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are copyright ©2000 
by LIMac. Opinions 
expressed are the 
views of the authors 
and do not neces sarily 
refl ect those of LIMac. 
Contents may be 
reprinted for non-
commercial use, with 
due acknowledgment 
to LIMac. The LIMac 
FORUM is an indepen-
dent publication and 
has not been author-
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Produced using: 
Tex-Edit Plus, Adobe 
InDesign, Photoshop, 
Illustrator and 
Acrobat.

The Internet SIG:  The Internet SIG meeting will be held at the Bethpage 
Public Library (516-735-4113) on Monday, January 15th, at 8 p.m. 
SIGs immediately after the general meeting:
Beginners SIG: How to set up and use the Launcher and Aliases. (We will 
meet at about 7:45 and will end the same time as the main presentation.) 
Mac Help SIG: The MacHelp SIG will do a hard drive swap on a iMac.

DTP/Photoshop SIG: Show your 
good stuff from a fl oppy disk.
Mutimedia SIG: Making multi-track 
QuickTime movies in Premiere.
x LIMac meetings, unless otherwise 
noted, are held in Building 300 
(Anna Rubin Hall) at the New York 
Institute of Technol ogy on Northern 
Blvd. in Old Westbury. 
| In bad weather, call 516-686-7789.
| The next LIMac board meeting 
will be at the Plainedge Library 
(516-931-3907) on Wednesday, 
January 17, at 8 p.m.

LIMac

A grand time was had by all as LIMac closed 
out 2000 with an action-packed Christmas 
party. Bradley did his Q&As; President Bill 
Medlow emceed the short business segment 
during which awards of appreciation were 
presented to FORUM Editor Mo Lebowitz and 
Web Master Bradley Dichter (photos, page 2), 
the raffle was next followed by demonstra-
tions of some games; and finally, a little food 
–  and a lot of talk. 

Scott Randell showed Snood. He says:
“This is a game that anyone can play. It starts 
off easy and as you get better you can go on 
to harder levels. The goal is to destroy all the 
Snoods before the touch the bottom of the 
screen. When that happens you lose the game. 
The trick to destroying Snoods is to group 
three of them together. The fewer number of 
Snoods you use to eliminate all of them (see 
screen shot) that are above, the higher your 
score. The ten highest scores are recorded 
until you get one higher than the lowest. 
Some aspects of the game are like a lesson 
in geometry. This is because you can bounce 
the Snoods off the sides of the screen. If you 
aim at the proper angle it will collide with the 
group of Snoods you want to destroy. There 
are other tricks you will learn once 
(Continued on page 2)

January’s main 
presentation will be 
a demonstration of 
Personal Organizer 
by an actual user! 
According to the 
software company, 
Chronos, Personal 
Organizer, its 
“award-winning 
Personal Informa- 
tion Manager, is the 
most powerful and 

intuitive personal information manager avail-
able today for the Macintosh. 

“Personal Organizer, seamlessly combines 
a calendar, address book and word processor. 
Plus, it synchronizes with your Palm pilot- 
and Visor-connected organizers (any model). 
It sports an elegant, customizable interface 
and is even smart enough to understand 
English phrases!” 

Of course, you won’t want to miss our 
regular Question and Answer session, the 
exciting raffle (which you can’t win if you’re 
not there to buy a ticket) and LIMac news and 
views  – all of which happens before the main 
presentation 0

–Rick Matteson
Friday, January 12, 7:00 p.m., Anna Rubin 
Hall (Bldg. 300), The New York Institute of 
Technology, Old Westbury. 
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Technical CornerPresident’s Message

Bradley Dichter
bdichter@cdr.net

Bill Medlow
President
ArchBill@aol.com

| I want to connect my old Performa 
running System 7.5.3 to my Xrouter cable 
router/hub and use it as a extra Internet 
terminal. Will there be a problem? The 
machine has 24MB of RAM. 
As long as you add an Ethernet card it 
should, in general, work, but its speed will 
be about as slow as a regular modem connec-
tion. Also, the old System will be a problem 
to file sharing with other Macs with Mac OS 
Extended format drives and the old System 
prevents you from using modern versions of 
browsers and plug-ins. With only 24MB of 
total memory, after the System loads, that 
leaves much less than 20MB for a browser, 
so that also means you have to leave off 
memory-hogging plug-ins, like Shockwave and 
RealPlayer, so overall the Internet experience 
will be bogus.
| I have an iMac with the wrong date, 
twice (1904). I don’t want to replace the 
battery. It does not loose the date every 
time I start up after it’s been off. Would 
rebuilding the Desktop help?
No, but zapping the PRAM might help, as 
would tossing the Date and Time Preferences 
and resetting the Control Panel. The problem 
is caused by some software that is crashing 
and corrupting your PRAM settings, or 
maybe the Date and Time Control Panel. 
| I have an  iMac DV SE 400MHz with 
new MS Intellimouse. Explorer has a sleep 
problem. It wakes itself up.
Look into updated MS Intellipoint 1.1 software 
or scrap it and use USB Overdrive 1.3.7 instead. 
The mouse be bad, try leaving software in 
place and try the old mouse. 
| I have a 10-month-old iMac that keeps 
freezing. I get a message to the effect that 
My drive is slow. What’s this all about and 
what can I do about it? I never added any 
new software. 
Sounds like some software is getting in the 
way and one part is having difficulty talking 
to another. I suggest running the Disk First 
Aid software in the Utilities Folder on your 
Macintosh HD. Also, check with the Apple 
System Profiler in the Apple Menu. You may 
have some substandard memory added to your 
computer and the Profiler can show this. 
| I was talking with my brother about Mac 

Photos by SmilePhoto. 

 TIP!

Dashes in Illustrator: 
For sign cutters (or 
anyone else) in 
Illustrator 8. To turn 
a dashed line into 
separate objects, it 
won’t work to simply 
stroke the path with 
a dashed line. Instead, 
create a dash of 
any length (any rect-
angle will do), select 
it and make a new 
Pattern Brush out of 
it (Window > Show 
Brushes > New 
Pattern Brush). Apply 
the Pattern Brush to 
your path by selecting 
the path and clicking 
on the Pattern Brush 
in the Brushes palette. 
Then, choose Object 
> Expand, with Object, 
Fill and Stroke all 
selected. 

Each dash is 
now an individual 
object, ready for a 
sign cutter or other 
need.

QuarkXPress.5 offers 
only minor upgrades 
for print designers 

– XPress’s core 
constituency: 
While support for 
tables and layers 
proper is a welcome 
addition (handled now 
by excellent 
XTensions), the 
majority of effort has 
gone into making 
QuarkXPress more 
useful in areas 
outside of its tra-
ditional strengths. 
Some folks will find 
use for XML support, 
but many designers 
will find the most 
notable upgrade to 
be support for Apple’s 
platinum appearance. 

Designers had 
hoped that QuarkX-
Press would respond 
to the challenge that 
InDesign represents 
by taking the oppor-
tunity to improve 
XPress’s H&J engine, 
hanging punctuation, 
etc. After all, it’s a 
tool that was devel-
oped for designers 
working in print.

 TIP!

On December 16, 2000 LIMac held an event 
at MicroCenter, one of the largest computer 
stores on Long Island. This event was suc-
cessful through the efforts of Rick Johnson of 
Market Source, Tom Gannon also of Market 
Source (who did the iMovie video editing on 
a new G4), and David Castillo, of Canon 
(who provided the LV-7525 projector that had 
up to 2,750 ANSI lumens – brighter mode). 
Castillo’s expertise provided some interesting 
information on the projector, Canon digital 
camcorders and videography. The videog-
raphy made at our last meeting as (well as 
at MicroCenter) was compiled by our own 
member, Bob Shipper, along with Rick and 
Tom. It was very interesting to see our group 
being documented for posterity as opposed to 
some kids washing their dog. 

I’ve meddled with QuickTime movies in 
the past, but it’s incredible to see how 
easily ours was put together – right down 
to the final credits. It’s my understanding 
that iMovie is free when you purchase any 
Macintosh that comes with a built-in FireWire 
connection. Or for $49 – provided you have 
Mac OS 9 and a FireWire. 

We have secured two-hours-worth of 
digital video (13Gigs) for use at our future 
Multimedia SIG meetings that will follow 
our general meetings each month. It is our 
intention to have this available in order to 
spend the time at these SIG meetings putting 
our own movie together, and discussing the 
merits and choices of a professional product 
as we do. 0

(Snoods, continued from page 1)
you download the program at www.snood.org/
index.html and start playing. There is a 
$10.00 (that’s right just ten) shareware fee. 
You can play the game for quite a while 
without it, but registering does unlock quite 
a few features, allows you to download new 
puzzles levels, and makes you eligible for 
upgrades. I am a believer in supporting share-
ware. Download Snood, try it for a while, if 
you like it, register. The $10.00 is well worth 
it. Snood provides hours of fun.” 0

Don’t forget to pay your 2001 LIMac dues.
Bring a check or cash for $26 to the next 
meeting or mail it in today!
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to Mac communications over the phone 
lines and he said no one is doing that 
anymore, it’s not worth it and I don’t see 
any software available to do it. Right? 
For the most part, that’s true. AppleWorks 
dropped the terminal emulation part of the 
package in the latest version and Microphone 
Pro hasn’t been updated in years (since 
1996), the original company went belly-up 
and Smartcom is also history. Microphone Pro 
is now sold ($90) by STF Technologies, a 
part of Smith Micro Software. (Anybody still 
remember RedRyder ?) The only remaining 
shareware choice is Alverson Software’s 
ZTerm 1.0.3 (from 1997.) The only thing close 
is where some service bureaus still use bul-
letin board programs for dial-up file transfer, 
so these programs still work; but you also 
see special client software like First Class 
and TeleFinder in use for these non-peer-to-
peer connections. Most people now use the 
Internet and e-mail attachments. 
| I have a G3 B&W. I want to show digital 
pictures (from a CD) on a TV. Is there an 
inexpensive way to do this? 
iAVerKey DV for about $100 or the AVerKey 
iMicro for $90. The iAVerKey300DV is their 
higher resolution model with extra features 
at $230. (See www.avermedia.com/products/
iaverkey_dv01.html for details.) It’s clear blue 
to match and it connects between your Mac’s 
VGA Monitor Connection and the display, 
giving you a composite or S-video connector 
for your TV monitor or VCR. The TV will 
then show to it’s best ability – the same as 
what is on the Mac’s display. Most TVs have a 
lower resolution than your Mac’s monitor. 
| I have an iMac DV SE 400MHz. When 
the mouse is stationary, the sound/music is 
fine, but video, cursor blinking, animated 
.gifs are slow. If I move the mouse, they’re 
fine. I’ve replaced keyboard and mouse. 
Look into fax software set to receive, scanner 
software looking for push buttons, AOL 
Instant Messenger’s IdleTime Extension, any 
screen saver, the Time Synchronizer function 
are all suspects. Not having enough memory 
can cause this, as virtual memory is rather 
slow. Some old and incompatible software can 
cause this. Conflict Catcher is good for fig-
uring out which Extension or Control Panel 

is at the heart of the matter. You may have 
turned on the Allow Processor Cycling option 
in the Advanced Settings section of the Energy 
Saver Control Panel.
| Where should I be with Norton Utilities 
and Mac OS 9.0.4 ? 
As per usual, the latest. Version 6 is preferred 
and is the only version that can start up this 
year’s latest models – the G4 Cube, the Gigabit 
Ethernet and multiprocessor generation G4 
minitower and the latest 350-500MHz Indigo/
Ruby/Sage/Snow iMacs. Version 6 can even 
work if you’ve been switching back and forth 
with the Mac OS X Public Beta. If you have a 
earlier model G3 or better machine, then you 
can use the previous version 5.0.3. If you have 
a Mac older than a G3, then I’ve found that 
the 5.0.3 CD may not start up the computer. 
So for these machines, you’ll have to go with 
even older version 4.0.3. By the way, if you 
do have a recent Mac, you may want to buy 
the bundle called Norton SystemWorks with 
included Norton AntiVirus 7, Dantz Retrospect 
Express and the (dangerous) Spring Cleaning.
|  I have a Belkin 4-Port USB Hub on my 
iMac and a Canoscan N56U scanner. With 
Mac OS 9.0.4, everything froze, then I got 
message that the scanner was not plugged 
in. I reinstalled the System, tried plugging 
in scanner directly and it worked. Can a 
scanner burn out the USB? 
You probably experienced a brief power outage. 
You just needed to unplug the power to the 
USB hub for a few seconds to reset it. I suggest 
a Belkin Regulator Pro Gold USB backup 
power supply for the iMac and the hub to 
prevent similar occurances. I’m thinking more 
and more freezes and crashes are due to bad 
power. This power supply will protect the 
equipment from surges and will boost brown-
outs before switching to it’s battery. 0

(Sore Eyes, continued from p.4)
I selected one of my platinum credit cards to 
use on-line, and only on-line. Since I use it 
only for that purpose, it’s easy to examine the 
bills and note any problems. So far, it’s been 
quite correct. My most used credit card, has 
a much longer (3–4 pages) bill and it’s harder 
to spot discrepancies, so I don’t use it on line 
at all. 0

 TIP!
An Easy Way To Print 
Portions Of Web 
Pages:
Did you ever need to 
print just one little 
piece of information 
off a Web site, but 
when you try to print 
it, you only end up 
getting five pages of 
paper with more then 
half of them being 
blank or just having 
half a line of text? 

To print better 
off the Net, I came 
up with a tip that 
has been working 
very well and to use 
it you don’t have to 
add a thing to your 
Extensions folder. 

When you need 
to print a small 
portion of text off 
a Web page, simply 
center the text so 
you can see it 
without scrolling and 
take a screenshot of 
the text you want by 
using the following 
key combination: 
Command-Shift-4. 
This will save a 
picture file of the 
information that you 
want to print on 
the Hard Disk. Now, 
when you’re ready 
to print simply open 
the picture file 
(located in Hard 
Disk folder) and use 
the Command-P key 
combo to print the 
item.

Layer Tips:
Fix the Emboss Filter: 
After applying the 
Emboss filter, choose 
Filter > Fade > Emboss 
and set the blending 
mode to Hardlight. This 
should get rid of all the 
shades of gray that the 
Emboss filter delivers 
and just give you the 
emboss effect.
LayerMask Tips: 
Shift-Click the Layer 
Mask thumbnail to tem-
porarily disable the 
Layer Mask. Option- 
Click the thumbnail to 
view the Layer Mask. 
Command-Click the 
thumbnail to load its 
contents as a selection. 
Drag the thumbnail to 
the Trash to discard it. 
The Layer Mask must 
be visible in order to 
paste an image into it.

When a selection 
is active, click on the 
Layer Mask icon to 
hide all the areas 
that are not selected, 
or Option-Click the 
icon to hide the area 
that is selected. If 
no selection is active, 
clicking the Layer 
Mask icon will not 
hide any part of the 
image, Option-Click 
will hide the entire 
layer.

To quickly switch 
between working on 
the Layer Mask and 
the main image, use  
Command - ~ to 
work on the image; 
or Command-\ to 
work on the Layer 
Mask.

 TIPS!

Create PDF Files Cheaply 
and Easily. 
PDF is a format was created to 
allow for an easy way to share 

documents between different types of computers. 
What’s great about the PDF file and what makes 
it so useful is that the file, along with a copy of 
Adobe’s Acrobat Reader, can be viewed on any 
modern computer, be it Windows or Macintosh; 
and because the document is done in a propri-
etary format allowing your document to look iden-

tical on any computer, no matter the OS. The 
format is an ideal way to show simple documents 
such as invoices or documents like brochures the 
way they were made to be seen without the need 
to either print or mail hard copies. 

The traditional way to create a PDF file 
requires you to both purchase and learn 
how to work an Adobe program – InDesign, 
PageMaker, etc. However, those of us who 
need to only create the occasional document 
in PDF format can benefit from a simple 

way to create the PDF file called PrintToPDF. 
PrintToPDF is not an actual program but rather 
a Macintosh printer Extension. To create a PDF 
file with this utility all that you will need to 
do is open up the Macintosh Chooser and 
select the PrintToPDF printer icon. Next, you 
will simply need to close the Chooser window 
and look for a PDF like printer icon on your 
Desktop. You can now create PDF files. To print 
the actual file, create an actual document 
in the graphic or word processing program 

of your choice. Then type Command-P. A 
PDF printer window will then appear on 
your screen. Choose the Print button and 
the PrintToPDF Extension will create a self-
contained PDF file and place it on your 
Desktop. And you finished creating your very 
first PDF file!

You can download PrintToPDF at www. 
jwwalker.com. 0

–Mac OS Planet Tutorial



Helen and
Sheldon Gross
shel9 @ bellatlantic.net

Sore Eyes

Note: These sites are 
referred to by us for 
your information only 
and neither we nor 
LIMac endorse any of 
the products or sites.
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Seaford, New York 11783
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 TIP!

Well, as anyone who has seen me in the last 
several months is aware, I’ve had a difficult 

“fall” season – pun definitely intended. I’m 
clearly on the mend, at this point but my 
activities have been much more restricted 
than usual. As a result, I have spent quite a bit 
of time surfing the Net, and thought I might 
tell you about some of the more interesting 
locations we’ve found.

First,gifts: All our holiday gift purchases 
were made on the Web. Books and CD 
items were purchased at www.amazon.com 
and  www.bn.com. Clothing came from  
www.llbean.com I tried www.gap.com for a new 
baby gift, but their Web site was not up to par. 
I had to call an 800 number to complete the 
purchase. The order acknowledgments came 
on e-mail, however.

One of our members, Herb Friedman, 
suggested a site that has newspapers from 
all around the world. www.thepaperboy.com is 
well worth a look. This site made it possible 
to follow the election returns with a variety 
of political spin and commentary. An article 
written by a friend was first printed in a 
California paper, and then reprinted in the 
BERGEN RECORD in New Jersey, and it was 
fun to be able to track its placement and effect 
on readers’ mail.

Our favorite movie review source at 
present is  www.nytoday.com This site is abso-
lutely great for new and current movie reviews. 
We discovered that one can go to the movies 
with crutches. It’s easier than in restaurants 
and taxicabs. But now that I’m no longer 
using the cast and can bend my knee, we’re 
almost back to normal. I’m not up to 
museums yet, but am on the way.

For security considerations, (Cont. page 3)

We had a great holiday party at our December 
meeting that was enjoyed by all of the mem-
bers present. We also began collection of dues 
for 2001. If you haven’t yet paid your 2001 
dues, please bring a check for $26 made out to 
LIMUG, Inc. Or you can mail in your dues to 
our P.O. Box. We are planning for a great year 
with many interesting presentations and we 
look forward to seeing you at our meetings. 

The current Mug Store ID and password 
are as follows: 
User ID: iBook 
Password: indigo 
www.AppleStore.com. 
Please check our Web site at www.limac.org 
for more timely information on items of 
interest to LIMac members. 

I want to conclude this month’s column 
by reprinting a short excerpt from an article 
published in the PHILADELPHIA INQUIRER 
(Dec. 27th, 1998) by Reid Goldsborough.

“User groups help people cut through the 
clutter. User groups provide trusted, digested 
information. User groups showcase the latest 
in hardware and software. User groups put 
on interesting presentations. User group mem-
bers have a history of helping each other. 
User groups often involve themselves in public 
service activities. Ultimately, computer user 
groups put a human face on all the bits and 
bytes. ‘It’s the humanity that can’t be dupli-
cated in an electronic environment.’ ” 0

Membership Drive for 2001 under way.
Your $26 dues check may be brought to the 
meeting or mailed to:
Long Island Mac Users Group
P.O. Box 518
Seaford, NY 11783 0

A Picture Locator in 
QuarkXPress: 
You can easily see the 
location on your Hard 
Drive of an imported 
picture by using 
Subscriber Options. 
Simply select the 
picture and choose 
Edit > Subscriber 
Options. In the 
resulting dialog box, 
click and hold on the 
fi le name to see the 
complete path back 
to the picture.

January’s main presentation will be a 
demonstration of Personal Organizer 
by an actual user! According to the 
software company, Chronos, Personal 
Organizer, its “award-winning Personal 
Information Manager, is the most 

powerful and intuitive personal information manager 
available today for the Macintosh.” 
Friday, January 12, 7:00 p.m., Anna Rubin Hall 
(Bldg. 300), The New York Institute of Technology. 

Max Rechtman
MaxLIMac@aol.com


